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Installing SAP HANA, express edition (Virtual Machine)

The SAP HANA, express edition VM image is platform-independent; you can install it to a Windows, OS X, or Linux machine, provided your host machine meets
the storage and memory prerequisites. Choose this installation method if you want the simplest setup.

Installing the OVA installs:

e AVM running SUSE Linux Enterprise Server (SLES) for SAP Applications 12 SP1.
e An SAP HANA, express edition instance on the VM, preconfigured and ready to start.

Machine Requirements
Check if your machine has the recommended hardware to successfully install and run the express edition VM image.

JRE 8 - The Download Manager requires JRE 8 or higher. If you are planning to install the SAP HANA, express edition Download Manager for Windows or Linux,
you need the 64-bit JRE. If you are planning to install the platform-independent Download Manager, you can use either the 32- or 64-bit JRE. RAM - 16 GB
RAM recommended.

HDD - 120 GB recommended.

Cores - 2 cores (4 recommended).

Hardware Virtualization - (Intel processors only) For Intel processors, virtualization is a BIOS setting known as either Intel Virtualization Technology or Intel VT.
Go to http://www.intel.com/content/www/us/en/support/processors/000005486.html to determine if your processor is capable of supporting virtualization. If
virtualization is turned off on your virtualization-capable machine, consult documentation from your machine vendor on how to enable virtualization
technology (or Intel VT) in the BIOS.

Install a Hypervisor

Install a supported hypervisor on your machine if you don't have one already. Hypervisors are software products used for creating and running virtual machines.
SAP HANA, express edition has been tested on these hypervisors:

e VMware Player 7.1: https://www.yvmware.com/

e VMware Workstation Pro 12.1: https://www.vmware.com/

e VMware Fusion or VMware Fusion Pro 8.x: https://wwwyvmware.com/
e Oracle VirtualBox: https://www.virtualbox.org/

For the purposes of this tutorial, you will use the VMware Player.

Install VMware Player

VMware Player 7.1 is a hypervisor compatible with SAP HANA express edition. You can install any supported hypervisor, but examples in this tutorial use VMware
Player 7.1.

1. Download VMware Player from <wwwvmware.com> and run the installer.
2. Ensure you're downloading the correct version for your machine.
3. Register when prompted and follow the setup instructions.

Download the OVA using the Download Manager

Register and then use the Download Manager to download a server-only OVA, or a server-plus-applications OVA. Applications include XS Advanced (XSA) and
Web IDE.

1. Go to the registration page at http://sap.com/sap-hana-express (Alternately, you can go to the SAP HANA, express edition launch page at
http://go.sap.com/developer/topics/sap-hana-express.html and click the Register and download SAP HANA, express edition download manager link.)
The registration page opens.

2. Complete the registration form and click the Register button.

Note: If you have an SAP login, click the Login icon at the top of the page to populate the registration form automatically.
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The Registration Success page displays. (You will also receive an email indicating successful registration.)

3. At the bottom of the Registration Success page, click the download manager that matches your system: Linux or Windows. If you have a Mac, or another
type of machine, click "other” for a platform-independent download manager.

w Run Simple

SAP HANA, express edition

Thank you for your registration. Please click on the applicable button below to quickly obtain the SAP HANA,
express edition download manager. This program is then used to choose the SAP HANA, express edition

components you wish to subsequently download.

To learn more about the power of SAP HANA, express edition we encourage you to visit the SAP Community

Network at: http://go.sap.com/developer/topics/sap-hana-express.html

There you will find links to valuable technical documents, tutorials, videos, demos, community chats and more.
Click on the applicable link below based on the operating system where you will run the SAP HANA, express
edition download manager. “Other” refers to a platform-independent JAR file. Note that a standard Java

runtime environment (Java & or newer) is required for use of the download manager.

Download the SAP HANA, express edition download manager below:

Linux
Windows
Other

4. Save the download manager installation file to your laptop and open it.
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5. If Windows prevents the download manager installation file from running, click More info on the warning message and select Run anyway.

Windows protected your PC

SmartScreen prevented an unrecognized app from starting. Running this app ht put your PC

6. In Download Manager, in the Image pull-down, select virtual machine.

Save directory |C:1.Users \Documents'tempidownloads

ct Package Size (MB) Status

Ser\rer—nnly 2038
Server + applications 2361
Text analysis files for additional languages A3V

Progress Detail

| Quit || Download

7. Click Browse and select a directory where your downloads will be saved.

8. Select one or more of the following packages:
Server only - Downloads hxe.ova ; a basic server-only package.
Server + applications - Downloads hxexsa.ova ; the server plus XSA and Web IDE.
Text analysis files for additional languages - For languages other than English and German, files required for the HANA Text Analysis function. (The text

analysis files for English and German are already included in the Server only and Server + applications packages.)

9. Click the Download button.

Import the OVA into VMWare Player
Import the downloaded OVA file into your hypervisor to begin using SAP HANA, express edition.

1. Start VMware Player 7.1 and select Open a Virtual Machine.
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Welcome to VMware Player

Create a New Virtual Machine

Create a new virtual machine, which will then be
added to the top of your library.

Open a Virtual Machine

Open an existing virtual machine, which will then be
added to the top of your library.

Upgrade to VMware Workstation

Get advanced features such as snapshots,
developer tool integration, and more.,

. Help
| |
'\\ _F/,f View YMware Player's help contents,

2. Browse to the OVA file you downloaded and click Open. The Import Virtual Machine dialog box displays.
3. Accept the defaults and click Import. The VM imports. The import process takes approximately 5 minutes.

4. Power on your VM.

Getting Started with SAP HANA, express edition

Start SAP HANA, express edition

1. Start the hypervisor and power on (or click Play on) your express edition VM.
2. At the hxehost login prompt, enter hxeadm
3. For Password enter the temporary password HXEHanal
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L] hxe - VMware Player =

Z.2808141 0:0:0: [=dal Assuming drive cache: write through
Z2.2811001 :0:0:0: [sdal Assuming drive cache: write through
2.2844521 0:0:0: [sdal Assuming drive cache: write through
3.631175] piix4 smbus 0DOD:00:07.3: Host SMBus controller not enabled!?

elcome to 3SUSE Linux Enterprisze 3erver for 3AFP Applications 12 5P1 (x86_64) - Kernel 3.1Z2.49-11-de
fault (ttyl).

SAP HANA, express edition 3P1Z2 server-only versiom

hxehost login: hxeadm

Password:

You are required to change your password immediately (root enforced)
hanging password for hxeadm.

(current) UNIX password:

4. When prompted for current (UNIX) password, enter the temporary password again:

5. When prompted for New password, enter a strong password with at least 8 characters. If your password is not strong enough, the system logs you off and
you must log in again.
Tip: Your strong password should contain numbers, upper and lower case letters, and special characters. It cannot contain systematic values, like strings in
ascending or descending numerical or alphabetical order.
Strong password example:
Note: Do not use this password example, since it is public and not secure. This example is for illustrative purposes only and must not be used on your
system. Define your own strong password.

6. When prompted to Retype new password, enter your strong password again.

SAP HANA, express edition is now running.

Test your Server Installation
Verify that all required SAP HANA, express edition services are running properly.

1. From the command prompt, enter:
HDB info
You should see the following services:

(server plus applications ( ) only)
Multiple services (server plus applications ( ) only)
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hxehost :hxeadm> HDB info
FPID »CFPU U3Z R3S COMMAND
2477 0. 14304 3044 -bash
2657 13196 1808 ~_ -rbinssh ~rusr-zap-HXE-HDBOO-HDE info
2757 26668 1344 ~_ ps fx -U hxeadm -o user,pid,ppid,pcpu,vsz,rss,args
1 20944 1640 sapstart pf=rusr-sap-HXE-3Y3-profile-HXE HDBOO hxehost
2228 2259952 36340 ~_ rusrssape-HHEAHDBBE>hwehaost -trace-hdb.sapHXE HDBOO -d -muw
2236 2005804 1192524 .~ ~_ hdbnameserver -
2236 1002196 304568 ~_ hdbcompi leserver
2236 1011492 287092 N\, ~_ hdbpreprocessor Py
2236 1303464 515644 T~a__hdbuebdispatcher "
1 492276 26356 rusr-sap-HXE-ADEOO7EXe”Sapstartsrv pf=rusr-sap-HXE-3Y3-profil

3
0.0
0.0
0.0
0.1
5.0
1.8
1.7
2.0
0.0

hxehost thxeadn> _

2. If you don't see these services, restart the database.
Enter. HDB stop then HDB start
Wait approximately 60 seconds for the system to start and the user prompt to return.

Change the Default Password for SYSTEM User
Changing the default SYSTEM user password can help secure your system.

1. From the command prompt, enter this command:
hdbsql -u SYSTEM -d SystemDB -p HXEHanal

2. Follow the command prompts to update the password.

Record Your VM's IP Address
Record the IP address of your VM so you can reference it later to connect using SAP HANA client tools.

1. At the command prompt, enter:
/sbin/ifconfig

2. Locate the IP address, listed under the ethe interface as inet addr .
In the following example, the IP address is 10.7.186.70
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& hxe - VMware Player = B
Player = - &u T =h » Ty

HDB info

PPID :<:CPU U3SZ  R33 COMMAND
2019 2018 13508 2040 -bash
2096 2019 13200 1816 ~_ -bin-sh -susr-sap-HXE-HDBOO-HDB start
2125 2096 Jo440 8780 ~_ susrr-sap-HXE-3Y8-exeshdbrsapcontrol —-prot NI _HTTP -wr
2365 719 14304 2956 -bash
2545 2365 13196 1808 ~_ -bin-sh -rusr-sap-HXE-HDBOO-HDB info
2576 2545 26668 1348 ~_ps fx -U hxeadn —o user,pid,ppid,pcpu,vsz,rss,args
1816 1 .7 492276 26184 -usr-sap-HXE-HDBOO-exe-sapstartsru pf=rusr-sap-HXE-8¥3 profil
2233 1816 .3 20936 2336 -~ =apstart pf=rusr-zap-HXE-3Y3-profile-HXE HDBOOD hxehost
2231 2233 .0 20944 1640 ~_ sapstart pf=rusr-zap-HXE-3Y3.-profile-HXE HDBOO hxehos
2242 2234 .4 225952 36340 ~_ susr-zap-HXE-HDBOO-hxehost-trace-hdb.sapHXE_HDBOD

N oooo oo

2258 2242 .8 2005804 1181692 ~_ hdbnamezerver

2476 2242 .4 1000396 308236 ~_ hdbconpileserver

2478 2242 .3 1006092 279044 ~_ hdbpreprocessor

2514 2242 .6 985876 216904 ~_ hdbuebd ispatcher
sshinsifconf ig

E'J.Luk-aaaeﬁ+ﬁthenn=t. HUaddr 0O0:0C:29:7B:F6:3nA

tﬂuiﬂf% addr:10.7.186.70 “Bcast:10.7.187.255 Mask:255.255.252.0
INETH a : ralc 29 (fe?b:f63dars6d 3cope:Link
UP BROADCAST RUNNING MULTICAST HMTU:1500 HMetric:1
RX packet=:38 errors:0 dropped:0 overruns:0 frame:0
IX packetz:43 errors:0 dropped:0 overruns:0 carrier:0
collisions:0 txqueuelen:1000
R¥ byte=:3891 (3.7 Kb) TX bytes:4433 (4.3 Kb)

Link encap:Local Loopback

inet addr:127.0.0.1 HMask:255.0.0.0

inet6 addr: ::1-128 3cope:Host

UP LOOPBACK RUNNING MTU:65536 Metric:1

R¥ packet=:4878 errors:0 dropped:0 overruns:0 frame:O0
TX packet=:4878 errors:0 dropped:0 overruns:0 carrier:0
collisions:0 txqueuelen:O

R¥ bytes:829979 (810.5 Kb) TX bytes:829979 (810.5 Kb)

hxehost hxeadmn>

Test XSC, XSA and Web IDE
If you installed the server plus applications ( ), test your XS installations and change the passwords of all XSA users.

1. Check that the is running. From your VM desktop, open a browser and enter:

You recorded the IP address in tutorial topic Record Your VM's IP Address. A success page displays:

XSEngine

is up and running

=

2. Change the passwords of all XSA users: a. Change the user password. Enter:
Follow the prompts to update the default password. b. Change the user password. Enter:

Follow the prompts to update the default password.
c. Change the user password. Enter:

Follow the prompts to update the default password.
3. Log in to XSA services:
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xs login -u xsa_admin -p <password>
4. Check for a series of entries beginning with https://<ip address of VM>:30030 . If you see these entries, XSA installed correctly.
5. Enter.
xs target -s SAP
6. View the list of XSA applications. Enter:
XS apps
7. Check that the application webide shows in the list of XSA applications.

8. Test your Web IDE connection.
On Windows, update the c:\Windows\System32\Drivers\etc\hosts file.
On Linux and macOS, update /etc/hosts to add the IP address.
Example:
<IP address of the VM> hxehost # <your IP address>

9. Enter the URL for Web IDE in a browser on your laptop. The address is the one that displays in your
XS apps
command output.
Example: https://<hostname>:53075

Configure SAP HANA Studio
Download SAP HANA Studio from the SAP HANA developer edition HANA Tools site to your laptop. Then connect to your SAP HANA, express edition instance.

. Download Eclipse Neon from https://eclipse.org/downloads/

. Review the installation procedure at https://tools.hana.ondemand.com/#hanatools. Ensure your laptop meets the prerequisites.
. Follow the installation procedure, but select Eclipse Neon.

When directed to the Eclipse packages site, select either Eclipse IDE for Java EE Developers or Eclipse IDE for Java Developers.
. Download to your laptop.

. Start the Eclipse installer.

. Select a workspace when prompted. The welcome page displays.

. Select Help > Install New Software.

. In the Work with field, type https://tools.hana.ondemand.com/neon and click Add. The Add Repository dialog box displays.

. In the Name field, type SAP HANA, express edition.

. Expand the SAP HANA Tools node.

. Select SAP HANA Administrator (Developer Edition).

. Accept the installation wizard prompts. Eclipse restarts.

© O N VAW N o
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. Select Window > Perspective > Open Perspective > Other.

-
w

. Select the SAP HANA Administration Console perspective.

-
o

. Right-click anywhere on the Systems tab and select Add System. The Specify System dialog box displays.

-
)

. Enter.
Host Name: (IP address you recorded in tutorial topic Record Your VM's IP Address)
Instance Number: 00

18. Ensure you click Multiple container mode and click System database. This is important because the system is configured to run on multi-tenant mode
with SystemDB as the default database out-of-the box.

19. Click Next. The Connection Properties dialog box displays.

20. Under Authentication by database user, enter.
User Name: SYSTEM
Password: (Password you specified when you changed the default SYSTEM password)

21. Click Finish. You are connected to HXE(SYSTEM).

Edit the /etc/hosts File
You may need to edit the /etc/hosts file on the VM.

1. Change
sudo echo <ipaddress> $(hostname -f) >> /etc/hosts
To
sudo sh -c 'echo <Type your IP Address> $(hostname -f) >> /etc/hosts'

Turn on Statistics Server ( nxe.ova Server-only Image)

If you downloaded hxe.ova, you can turn on statistics server from the command prompt.

1. Enter:
hdbsql -d SystemDB -u SYSTEM -p <system passwd
> “alter system alter configuration( ‘nameserver.ini','SYSTEM' ) SET ( 'statisticsserver','active' ) = 'true' with reconfigure”

Configure Security
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Apply the HANA, express-edition license key

If you don't apply the license, your SAP HANA, express edition will stop working after the default grace period of 60-90 days. If you have SAP HANA Studio or

the HANA Studio eclipse plugin then begin at Using Studio. Otherwise proceed to Using HDBSQL.

Applying the License Key with HANA Studio

Obtain your hardware key
If you are using the SAP HANA Studio eclipse plugin, you can do the following.

. Start SAP HANA studio.

. On the Systems tab, select SYSTEMDB@HXE (SYSTEM).
. View properties for SYSTEMDB@HXE (SYSTEM).

. Select License properties. Open the System License tab.

U A W N =

. Make a note of the Hardware Key value.

Order your license key

. Go to http://sap.com/minisap page and fill out all required information.
. For System ID, select HXE.

. For Hardware Key, enter the hardware key value you recorded earlier.

. Submit the form. The license key is emailed to you.

U A W N =

. Save the license key file to your hard disk under the name HxE.txt .

Apply the license key

. In SAP HANA studio, view properties for SYSTEMDB@HXE (SYSTEM).
. Select License properties. Open the System License tab.

. Click Delete License Key to delete any existing licenses.

. Click Install License Key.

U A W N =

. Navigate to your license file and select it.
After confirmation, the properties page refreshes with your new license information.
6. Proceed to Change the SSFS Master Keys

Applying the License Key with HDBSQL

Obtain your hardware key
1. Login in to your HANA, express edition as hxeadm .

2. Enter the following command:

hdbsql -u system -p <your password> -d SystemDB "SELECT HARDWARE_KEY FROM M_LICENSE"

3. Copy or otherwise record the value returned for HARDWARE_KEY .

Order your license key

. Go to http://sap.com/minisap page and fill out all required information.
. For System ID, select HXE.

. For Hardware Key, enter the hardware key value you recorded earlier.

. Submit the form. The license key is emailed to you.

A W =

. Save the license key file to your hard disk under the name HXE.txt .

Apply the license key
1. Make a directory on your HXE machine to store the license.
mkdir ~/license

This command will make the directory /usr/sap/HXE/home/license

2. If you do not have an SCP client, please download and install one. There are several very good open source scp clients available for Windows, Mac and

Linux. Copy the file from your hard disk to the /usr/sap/HXE/home/license directory.
3. Issue the following command to install the license key.

hdbsgl -u system -p <password> -n localhost:30013 -m -i <instance number> <<EOF
SET SYSTEM LICENSE 'cat /usr/sap/HXE/home/license/HXE.txt'’;
EOF
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Note: Make sure the license file string is surrounded by single quotation marks. After the license file string closing single quotation mark, make sure you
include the back-tick and semicolon. For <password> and <instance number> etc., input values matching your SAP HANA, express edition settings.

4. Confirm that the license key was installed by issuing the following command.
hdbsql -u system -p <password> -d SystemDB "select hardware_key, expiration_date from m_licenses"
The expiration date should be one year from today.

5. Proceed to Change the SSFS Master Keys.

Change the SSFS Master Keys

The secure stores in the file system (SSFS) used by SAP HANA are protected by unique master keys, generated during installation or update. If you installed HXE
from an OVA, then it shares master keys with other HXE systems. We recommend that you change the master keys immediately after setup to ensure that your
master keys are not known outside your organization. For more information on changing the master keys, see the Change the SSFS Master Keys topic in the
SAP HANA Administration Guide.

1. Log on to the HANA system as hxeadm and shut the system down using the sapcontrol program:
/usr/sap/hostctrl/exe/sapcontrol -nr 00 -function Stop
2. Re-encrypt the master key of the instance SSFS:
export RSEC_SSFS_DATAPATH=/usr/sap/HXE/SYS/global/hdb/security/ssfs
export RSEC_SSFS_KEYPATH=/usr/sap/HXE/SYS/global/hdb/security/ssfs
rsecssfx changekey $(rsecssfx generatekey -getPlainValueToConsole)

3. Add the following entry to the global.ini file using a text editor. (HANA, express edition, comes with the vi and vim text editors) The global.ini file
is located here: /usr/sap/HXE/SYS/global/hdb/custom/config/global.ini

Add or edit the cryptography section with the following value.

[cryptography]

ssfs_key_file_path = /usr/sap/HXE/SYS/global/hdb/security/ssfs
4. Re-encrypt the system PKI SSFS with a new key - HDB start:

export RSEC_SSFS_DATAPATH=/usr/sap/HXE/SYS/global/hdb/security/ssfs

export RSEC_SSFS_KEYPATH=/usr/sap/HXE/SYS/global/hdb/security/ssfs

rsecssfx changekey $(rsecssfx generatekey -getPlainValueToConsole)
5. Restart the system:

/usr/sap/hostctrl/exe/sapcontrol -nr 00 -function Start

Change the Root Key

SAP HANA generates unique root keys on installation. If you installed HXE from an OVA, then it shares a root key with other HXE systems. We recommend that
you change the root key of the internal data encryption service to ensure it is not known outside your organization. For more information on this topic, see the
Change the Root Key of the Internal Data Encryption Service topic in the SAP HANA Server Installation and Update Guide.

1. Log on to the HANA system as hxeadm and shut the system down using the sapcontrol program:
/usr/sap/hostctrl/exe/sapcontrol -nr 00 -function Stop
2. Generate a new root encryption key using the hdbnsutil program:
cd /usr/sap/HXE/HDB0O®/exe
./hdbnsutil -generateRootKeys --type=DPAPI
3. Restart the system:
/usr/sap/hostctrl/exe/sapcontrol -nr 00 -function Start
4. Reset the consistency information in the SSFS using the hdbcons program:
cd /usr/sap/HXE/HDB0O®/exe
./hdbcons "crypto ssfs resetConsistency" -e hdbnameserver
5. After running the hdbcons command you have 20 seconds to rerun the command again to completely rewrite ssfs consistency information:

./hdbcons "crypto ssfs resetConsistency" -e hdbnameserver
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6. Change all application keys so that they are encrypted with the new root key by using SAP HANA studio or SAP HANA HDBSQL:

hdbsql -u system -p <YourPassword> -d SystemDB "ALTER SYSTEM APPLICATION ENCRYPTION CREATE NEW KEY"

Troubleshooting

Download Manager Internal Error: "downloaded size does not match content length”

Issue

You are downloading packages using Download Manager. The download fails. The Download Manager log file displays this error message: Internal error:
downloaded size does not match content length The Download Manager log file is located at /tmp/hxedm_[yymmdd].log on Linux and
%TEMP%\hxedm_[yymmdd].log on Windows.

Solution

Either the file on the download server changed since your last download session, or partial download files from your previous download session are corrupted.
Delete *.001 to *.eeg files in your download directory and run the Download Manager again.

Download Manager Error Message: "Failed to verify {0} checksum"

Issue

You are downloading packages using Download Manager. The download fails and this error displays: Failed to verify {O} checksum

Solution

Either the file on the download server changed since your last download session, or the download file is inaccessible/corrupted. Delete the download file and/or
.00* in the download directory and run the Download Manager again.

Download Manager Error Message: "Failed to join downloaded files"

Issue

You are downloading packages using Download Manager. The download fails and this error displays: Failed to join download files

Solution

Download manager failed to assemble the download file. This might be because of lack of disk space in the download directory. In Linux, run: cat .001 .002
.003 .004 .005 .006 .007 .008 > < final filename >

In Windows, run: type .001 .002 .003 .004 .005 .006 .007 .008 > < final filename >

Virtual Machine: Checking Resource Usage

Issue

You are having memory issues on your VM and want to check resource usage.

Solution

If you have HANA studio, right-click on the system and select Configuration and Monitoring > Open Administration and check the Overview and
Landscape tabs for anything in red.

If you don't have HANA Studio, run the following queries in hdbsql to view SAP HANA resource usage:

select service_name, round(effective_allocation_limit/1024/1024/1024, 1) as MemLimit, round(total_memory_used_size/1024/1024/1024,1) as
MemUsed from m_service_memory;

If the MemUsed is close to the MemLimit , you may encounter problems allocating memory.
Alternatively, you can run the Linux free command at the command line to see free resources:
free -g

The key number is in the second row (-/+ buffers/cache) in the free column. If this number is low, (e.g. 1 GB) you may have run out of memory when
performing your recent operation.

You can also run the following command to see if you are running out of disk space on the VM's filesystem:

df -h

Look for the Use% for the /dev/sdal filesystenm.Ifitis down to just a few GB, you may have run out of disk space when performing your recent operation.
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Updating the Installation

Download and Extract the Installation Files

1. Using the download manager, select Binary Installer and download the Server only package. If you are updating a Server + applications virtual machine,

download the Applications package as well.
2. Using an FTP client, copy the packages from your local machine to the virtual machine.

3. Extract the contents of the packages.

Update the Server Installation
1. Navigate to the following directory:

cd <download_path>/HANA_10_DEE/DATA_UNITS/HDB_SERVER_LINUX_X86_64

2. As the root user, run one of the following commands to begin the SAP HANA server update:

sudo ./hdbupd --ignore=check_min_mem,check_plugin_dependencies

3. Follow the prompts to complete the server update.

Update the Applications Package
1. Navigate to the following directory:
cd <download_path>/HANA_10_DEE/DATA_UNITS/HDB_SERVER_LINUX_X86_64

2. As the root user, run the following command to update XSA applications:

sudo ./hdblcm --action=update --components=xs --xs_components=all --configfile=configurations/auto_install.cfg --component_medium=

<download_path>/HANA_10 DEE
3. Follow the prompts to complete the XSA update.
4. Asthe hxeadm user, log in to XSA services:

xs login -u XSA_ADMIN -p <password>
5. Stop the jobscheduler services:

Xxs stop jobscheduler-rest

xs stop jobscheduler-service
xs stop jobscheduler-backend
Xxs stop jobscheduler-broker

© 2017 SAP SE or an SAP affiliate company. All rights reserved.



Important disclaimers and legal information

Coding Samples

Any software coding and/or code lines / strings ("Code") included in this documentation are only examples and are not intended to be used in a productive
system environment. The Code is only intended to better explain and visualize the syntax and phrasing rules of certain coding. SAP does not warrant the
correctness and completeness of the Code given herein, and SAP shall not be liable for errors or damages caused by the usage of the Code, unless damages
were caused by SAP intentionally or by SAP's gross negligence.

Accessibility

The information contained in the SAP documentation represents SAP's current view of accessibility criteria as of the date of publication; it is in no way intended
to be a binding guideline on how to ensure accessibility of software products. SAP in particular disclaims any liability in relation to this document. This disclaimer,
however, does not apply in cases of wilful misconduct or gross negligence of SAP. Furthermore, this document does not result in any direct or indirect
contractual obligations of SAP.

Gender-Neutral Language

As far as possible, SAP documentation is gender neutral. Depending on the context, the reader is addressed directly with "you", or a gender-neutral noun (such
as "sales person” or "working days") is used. If when referring to members of both sexes, however, the third-person singular cannot be avoided or a gender
neutral noun does not exist, SAP reserves the right to use the masculine form of the noun and pronoun. This is to ensure that the documentation remains
comprehensible.

Internet Hyperlinks

The SAP documentation may contain hyperlinks to the Internet. These hyperlinks are intended to serve as a hint about where to find related information. SAP
does not warrant the availability and correctness of this related information or the ability of this information to serve a particular purpose. SAP shall not be liable
for any damages caused by the use of related information unless damages have been caused by SAP's gross negligence or willful misconduct. All links are
categorized for transparency (see: http://help.sap.com/disclaimer).

© 2016 SAP SE or an SAP affiliate company. All rights reserved.

No part of this publication may be reproduced or transmitted in any form or for any purpose without the express permission of SAP SE or an SAP affiliate
company. The information contained herein may be changed without prior notice. Some software products marketed by SAP SE and its distributors contain
proprietary software components of other software vendors. National product specifications may vary.

These materials are provided by SAP SE or an SAP affiliate company for informational purposes only, without representation or warranty of any kind, and SAP or
its affiliated companies shall not be liable for errors or omissions with respect to the materials. The only warranties for SAP or SAP affiliate company products and
services are those that are set forth in the express warranty statements accompanying such products and services, if any. Nothing herein should be construed as
constituting an additional

SAP and other SAP products and services mentioned herein as well as their respective logos are trademarks or registered trademarks of SAP SE (or an SAP affiliate
company) in Germany and other countries. All other product and service names mentioned are the trademarks of their respective companies.

Please see http://www.sap.com/corporate-en/legal/copyright/index.epx for additional trademark information and notices.

© 2016 SAP SE or an SAP affiliate company. All rights reserved.
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